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For information on using the RealAudio Player for Windows, choose one of the topics below.    

Quick Start 
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View Menu 
                  Preferences Dialog
                  Statistics Dialog
Clip Menu
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Troubleshooting 

For the latest information on RealAudio products and Web sites, visit the Progressive Networks home 
page at: 

http://www.realaudio.com

The latest support and technical information is available at:

http://www.realaudio.com/help.html



 Quick Start 
The RealAudio Player provides real-time audio on demand over the Internet.    For the latest information 
on RealAudio products and Web sites, visit the Progressive Networks home page at:
 

http://www.realaudio.com

Playing Audio
After installing the RealAudio Player, click any RealAudio link on a World Wide Web page and the Player
will start automatically.    (You do not need to first load the RealAudio Player, it will be loaded by your 
Web browser.)    For a frequently updated listing of World Wide Web sites containing RealAudio links, 
see

http://www.realaudio.com/raguide.html

Supported Audio Formats
The RealAudio Player plays two kinds of files:

1)    RealAudio files, which end with a .ra, 
2)    RealAudio meta files, which end with a .ram extension.    

To convert .au or .wav files to RealAudio format, use the free RealAudio Encoder, available from the 
Progressive Networks Web site.

Volume Control
Volume control is available when the Info & Volume option on the View menu is checked.    To adjust the 
volume using the Player, move the fader.    You can also control the volume by adjusting the master 
volume in the mixer application supplied with your sound card or with Windows. If there is no volume 
control visible on your Player, your Windows sound driver does not support volume control from within 
stand-alone applications such as the RealAudio Player.    In this situation please use the volume control 
on your speakers or on the sound card mixer.

If you do not hear any sound or the volume is very low, check the volume control on your speakers and 
your mixer settings for Wave and Master volume.

Home Button
The Home Button is the speaker to the right of the forward and backward seek buttons.    Clicking on the 
Home Button will bring you to the Progressive Networks Home Page.    The Home Button spins when the
Player is buffering and contacting the Server.    Animated sound waves will come out of the speaker 
when the Player is playing.    A lightning bolt will appear in the Home Button any time data packets are 
lost during transmission. 
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 Player Messages

If you have selected Status Bar from the View Menu the status bar at the bottom of the Player displays 
one of the following messages:

Buffering. When you connect to a link on a Web page, the audio stream received by the Player collects 
in the buffer (holding area) until enough packets arrive to start playing the audio stream. This takes only 
a few seconds. 

(Clip x of y). When the RealAudio Player has been told to play more than one RealAudio (.ra) file in a 
row, you will be told how many total clips are to be played, and to which clip you are currently listening. 

Stopped. When you select Stop or Pause this message is displayed. 

Playing (14.4 or 28.8) network stream. This message is displayed when the Player is playing audio 
over the Internet. The number (14.4 or 28.8) indicates the type of compression algorithm used to encode
the file. If you do not hear any audio while this message is displayed, adjust the volume on the Player 
and on your speakers. If you are still having problems, you may need to adjust the Wave volume in your 
mixer application. 

If you are using Windows 3.1x, look for your sound card files. You should be able to access
your wave mixer from there. 

If you are using Windows 95, chose Multimedia from the Control Panel and adjust the 
Audio Playback volume. 

Playing (14.4 or 28.8) local stream. This message is displayed when the Player is playing audio a clip 
from a local file rather than over the Internet. The number (14.4 or 28.8) indicates the type of 
compression algorithm used to encode the file.

Playing (14.4 or 28.8) live stream. You will see this message when playing a live event across the 
Internet.    The number (14.4 or 28.8) indicates the type of compression algorithm used to encode the 
file.

Contacting Host. The Player is requesting a file from a RealAudio Server. 

The display to the right of the message line indicates how long the clip has been playing and the total 
length of the clip. Note that the total length of the clip is not shown when listening to a live network 
stream. 
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 File Menu 
Commands on the File menu enable you to play RealAudio files directly from the Player without using 
your Web browser.

Open Location
Allows you to play RealAudio files from a RealAudio Server on the Internet without using your Web 
browser.    Simply enter the URL of the .ra file.    You must use the pnm (Progressive Networks Metafile) 
address of the file; URL types such as http, ftp or gopher will not work.    The address should have the 
following syntax:

pnm://RealAudioServer:Port#/complete-path-to-file

where:

pnm specifies that the file is located on a RealAudio server
ServerName is the IP address or Domain name of the RealAudio Server
Port# is the port number the Server is using if other than the default port 7070
complete-path-to-file is the complete path to the file on the RealAudio Server

For example

pnm://audio.realaudio.com/welcome.ra

This option is most useful to those who wish to test the RealAudio Servers they maintain.    For general 
use of the Player it is easier to use your Web browser.

Open File
Allows you to play local RealAudio files.    Select an .ra or .ram file in the Open File dialog.

Open Recent
The RealAudio Player remembers the most recently played RealAudio clips. The Open Recent menu 
shows the file name of your most recent clips.    To listen to a clip you have recently played, select the 
appropriate file name from the Open Recent menu.    You do not need to have your Web browser open.   
By default the RealAudio Player remembers the names of the 4 clips to which you have listened most 
recently.    You may change this default by editing your Preferences.
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 View Menu 
Commands on the View menu allow you to modify the appearance of the Player and to set audio and 
network options.

Info and Volume
Displays or hides the volume control and the title, author, and copyright information for the clip.    To 
adjust the volume using the Player, move the fader.    If there is no volume control visible on your Player, 
your Windows sound driver does not support volume control from within stand-alone applications such 
as the RealAudio Player.

Status Bar
Displays or hides the Status Bar, which shows the current status of the Player, the length and position of
the RealAudio file, and help text for the menu commands.

Preferences 
Displays the Preferences settings for configuring the Player. Preferences can also be viewed by right 
clicking on the RealAudio Player and selecting Edit Preferences or by using the Ctrl-P shortcut from your
keyboard.    Preferences is greyed out and inaccessible while the Player is playing.    

Statistics
Displays transmission quality information in the Connection Statistics dialog.    Statistics can also be 
viewed by right clicking on the RealAudio Player and selecting View Statistics.

Always on Top
When selected, the RealAudio Player remains on top of all other windows, even when another window is
active.    Always on Top is convenient for keeping the Player visible while you interact with your Web 
browser.
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 View Menu - Preferences Dialog 
Settings in the Preferences dialog allow you to set preferences on your Player, network connections, 
proxy configuration and sound output.    These settings cannot be changed while the Player is playing.    
The four tabs in the Preferences dialog are the General Tab, Network Tab, Proxy Tab, and Advanced 
Tab.



 Preferences - General Tab
Remember the [ ] Most Recent Clips
Allows you to set the number of clips that you want the RealAudio Player to remember and display when 
using the Open Recent command from the File Menu.    The default is 4; the number of remembered 
clips can be reset from 0 to 99.

Audio Quality vs. CPU Usage
To achieve the best sound quality from the RealAudio 28.8 algorithm, your computer needs to process 
Internet data quickly. Pentium machines are best suited for this data processing. If your machine 
experiences a drastic decrease in performance when you are listening to RealAudio, you may want to 
change this option from Best Audio Quality (the default) to Lowest CPU Usage, or to a setting in 
between.

Synchronized Multimedia
Enabling Synchronized Multimedia (the default) allows the RealAudio Player to trigger new Web pages 
during a RealAudio Synchronized Multimedia clip, thus providing a narrated slide show. By disabling 
Synchronized Multimedia, you prevent the RealAudio Player from turning new Web pages in 
Synchronized Multimedia RealAudio clips.



  Preferences - Network Tab
This group of preferences sets how the Player will receive audio clips, how long the Player will wait for a 
Server to connect, whether the Player sends statistics to the Server, and whether the Player will correct 
for lost data.    The descriptions of these preferences assume a basic knowledge of Internet protocols 
and firewalls.

Receive Audio Via
The default behavior for RealAudio is to receive RealAudio data packets via UDP.    Some people behind
packet-filtering firewalls cannot receive UDP packets.    If you cannot receive UDP packets, set this 
preference to TCP only.    NOTE: Older Beta RealAudio 2.0 Servers do not support the TCP-Only option. 
Your RealAudio Player status will say "Buffering..." without playing audio if you encounter one of these 
Servers.    Please ask the owner of the Server to upgrade to the RealAudio 2.0 Server.

Use Specified UDP Port
Firewall administrators may want to configure packet-filtering firewalls to receive UDP through one 
specified port. The RealAudio Player can receive UDP packets through any designated port between 
1,000 and 9,999. Your firewall administrator should tell you what port to specify. Note: RealAudio TCP 
packets can only go through Port 7070.

Sever Timeout
Specifies the maximum number of seconds the RealAudio Player will wait to connect to a RealAudio 
Server.    If it does not connect within this time period, a Retry/Cancel message will be displayed.    The 
default value is 30 seconds.    A value of 0 indicates the Player will wait indefinitely to connect to a 
RealAudio Server.

Send Statistics
Controls whether the RealAudio Player sends connection quality statistics to the RealAudio Server after 
playing a clip.    This feature helps content and service providers assure transmission quality.    This 
information is similar to what you see in the Connection Statistics dialog:

the number of packets received
the number of packets lost in transmission
the number of packets arriving late
the number or packets which arrived early
the number of packets which arrived out of order

Please note that the RealAudio Player does not access, or send to the Server, any information about 
your identity (such as your UserName, e-mail address, or password).

Loss Correction
When Loss Correction is checked, the RealAudio Player compensates for packets lost in transmission 
between the RealAudio Server and your Player.    You may hear a momentary warble in the audio stream
if packets are missing.    When Loss Correction is unchecked, the lost packets are dropped, causing a 
skip.

Bandwidth
This option allows you to indicate your computers type of Internet connection.    RealAudio content 
providers now have the option of using a feature called bandwidth negotiation.    This allows them to offer
a file in both 14.4 and 28.8 algorithms, while only putting one link on their site.    The RealAudio Player 
sends information about your Player to the Server to assure that you get the file type appropriate for your
computer.    The file type you receive is based in part on the speed of your connection to the Internet.





 Preferences - Proxy Tab
A proxy server is a server that acts as an intermediary between a company's protected LAN and the 
Internet.    The proxy server ensures that all data transmission between the Internet and a user on the 
LAN is authorized.    The RealAudio 2.0 Player can be configured to work with proxy servers by setting the
proxy preferences.

Use Proxy
By checking this box, you instruct the RealAudio Player to connect to the Server via a proxy. You MUST 
specify a host name and port number if you check this option. 

Host
The host name is the domain name or IP Address of the proxy server. If you are behind a firewall and do 
not know the host name of your proxy server, ask your firewall administrator.

Port
You must specify what port the RealAudio Player should use to communicate with the proxy server. If 
you are behind a firewall and do not know the port number of your proxy server, ask your firewall 
administrator.

No Proxy For
You may specify certain local hosts (domain names or IP Addresses) with which you do not need to 
communicate via the proxy server. Your firewall administrator may provide you with appropriate local 
hosts. 



 Preferences - Advanced Tab
Advanced Preferences override Player defaults for sound card compatibility.

Use 8-bit Only
Use this option only if there is evidence of compatibility problems with your sound card.    The Player 
normally delivers 16-bit audio to the sound card.    If the sound card only supports 8-bit audio, the Player 
delivers 8-bit audio.    If your sound card fails to inform the RealAudio Player that it only supports 8-bit 
audio, you may hear only random or garbled sound when playing clips.    Check this option to override 
the 16-bit default and play 8-bit sound.

Use 11 kHz Only
Use this option only if there is evidence of compatibility problems with your sound card.    The Player 
normally delivers 8 kHz audio to the sound card.    If your sound card does not support the 8 kHz 
sampling rate, the audio may sound high-pitched or too fast.    Check this option to instruct the Player to 
convert audio to 11 kHz before delivering it to the sound card.    This option increases CPU usage 
slightly.



 View Menu - Connection Statistics Dialog 
This option opens the Connections Statistics window.    This window reports the performance of the 
Internet connection between the RealAudio Server and the RealAudio Player.    It shows the number and
percentage of data packets received, lost, late, early, lost in the last 30 seconds, and out of order.    
Missing data packets create a momentary warble in the audio or, if Loss Correction is turned off, a skip.

If you experience degraded sound quality due to lost data packets, the cause may be temporary network
transmission difficulties or extremely heavy loads on the Server site.    You may wish to try again later or 
to visit another site.

If you consistently experience high rates of loss and you use a dial-up Internet connection, your modem 
may be connecting at less than 14.4 Kbps, or your Internet Service Provider may not be providing 
sufficient bandwidth to service your connection.    Contact your system administrator.

The Player will display a lightning bolt in the Home Button if there is any packet loss.



 Clip Menu
Commands from the Clip menu allow you to jump forward or backward in a multi-clip RealAudio (.ram) 
file. This functionality is similar to the forward and backward seek buttons on a CD player. If there is only 
one RealAudio clip at the link you are accessing, this feature will be greyed out. The following options are 
available on this menu:

 

Previous Clip
Allows you to play the previous clip in a multi-clip RealAudio (.ram) file.

Next Clip
Allows you to play the next clip in a multi-clip RealAudio (.ram) file.

Quick Start 
Player Messages
File Menu 
View Menu 
Site Menu
Troubleshooting 



 Site Menu
Commands from the Site menu allow you to access various pages at the Progressive Networks Web 
site. This feature works with most popular Web browsers including Mosaic, Spyglass Mosaic, Spry 
Mosaic, Netscape, and Internet Explorer. If your Web browser is not open, the Player will open it for you.
The Site Menu allows you to directly access the following pages: 

RealAudio Home Page... Brings you to the Progressive Networks home page 
(http://www.realaudio.com). 

RealAudio Guide... Brings you to a listing of Web sites providing RealAudio content 
(http://www.realaudio.com/raguide.html).

RealAudio Help... Brings you to RealAudio's main Help and Frequently Asked Questions page 
(http://www.realaudio.com/help.html).
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 Troubleshooting 
This document contains information on the following troubleshooting topics:

No sound or garbled audio: sound card compatibility
Garbled audio: other causes
Web browser prompts for Save To Disk instead of launching Player
Audio will not play: Firewalls
Audio will not play: TIA (The Internet Adapter )
Configuring a Web browser for RealAudio
MIME Types

If you experience any other problems with the RealAudio Player, please consult the latest 
troubleshooting information and FAQ (Frequently Asked Questions) available on the Progressive 
Networks Web site at:

http://www.realaudio.com/help.html

No sound or garbled audio: sound card compatibility
The RealAudio Player has been extensively tested with a wide variety of sound cards under all versions 
of Windows.    However, if the sample complete.ra and thankyou.ra clips played by the installation 
program are garbled or do not play, follow these steps to resolve the problem:

1. Contact the card manufacturer to obtain the latest drivers.    Updated drivers solve most 
compatibility problems.

2. Try selecting the Use 8-bit only and Use 11 kHz options in the Advanced section of the 
Preferences dialog.    To test playback, use the Open File dialog and select start.ram from the 
Player installation directory.

3. If the above steps do not solve the problem, visit

 http://www.realaudio.com/help.html 

Garbled sound: Other causes
There are several other causes of poor sound quality.

If you have an older computer or are using an external modem your computer may not have a UART 
chip that is capable of handling the data flow needed for optimal sound quality.    Sound packets will get 
lost.    Your Windows diagnostic utility should be able to identify your computers type of UART chip.    The
chip should be a 16550. 

Another cause of poor sound quality is packet loss due to network traffic.    There can be a difference in 
connection quality from one site to another.    Use the Statistics dialog box to find out if packet loss is 
occurring.    A network monitor such as WS-Watch can help you determine where packet loss is 
occurring.    

Web browser prompts for Save To Disk instead of launching Player



If your Web browser displays a prompt with options such as Save to Disk instead of launching the 
RealAudio Player, your Web browser probably has not been configured correctly.    If your system or 
browser configuration has changed since running the Setup program, the easiest solution is to reinstall 
the Player.    If the problem persists, consult the section on Configuring a Web browser for RealAudio.

If you see a Save to Disk prompt only on a particular site or clip, that site's RealAudio Server may not be
configured correctly.    First verify that your Player is configured correctly by attempting to play clips on 
the Progressive Networks Web site (http://www.realaudio.com).    Then, if your Player is properly 
configured, contact the site administrator and do not adjust your configuration.

Audio will not play: Firewalls
RealAudio uses port 7070 for TCP and ports 6970 through 7170 inclusive for UDP transmission. If you 
are accessing RealAudio through a firewall, you will need to configure your Player to your firewall setup. 
Contact your firewall administrator for more information. You can point your administrator to our firewall 
page at
 

http://www.realaudio.com/firewall.html

for details.

Audio will not play: TIA (The Internet Adapter)
TIA is a program that provides pseudo-SLIP access to the Internet.    If your dial-up connection does not 
allow you to play RealAudio, your Internet provider may be using an older version of TIA.    Symptoms of 
a TIA connection include a Player that halts after the Buffering Status message when attempting to play 
a clip.    TIA beta release 2.1 is compatible with RealAudio.    If you are experiencing problems that may 
indicate a TIA connection, contact you Internet Service Provider and ask them to upgrade to TIA 2.1 
beta. 

Configuring a Web browser for RealAudio
The RealAudio Player Setup program automatically recognizes and configures all popular Windows Web
browsers installed on your computer.    If your browser is not recognized by the Setup program, or is 
newer than this release of the Player, you may need to configure the browser manually.

First, check for information related to your browser in the RealAudio FAQ (Frequently Asked Questions) 
at 

http://www.realaudio.com/help.html
 

If information is not available, consult your browser documentation on configuring Helper Applications or 
External Viewers.    Add the RealAudio Player as an application with the following information:

MIME type: audio/x-pn-realaudio
Extensions: .RA, .RAM
Application: raplayer.exe (The default installation directory is c:\raplayer.)

MIME Types
World Wide Web browsers refer to MIME types to determine what action should be performed for a 
particular link.    Most of the time, a consistent set of file extensions are used for each MIME type.    In 
your browser, you determine what actions should be taken to display each MIME type.    You can change
these actions by changing the values under Helper Applications or External Viewers.    For RealAudio 
files, the MIME type is audio/x-pn-realaudio.    See Configuring a Web browser for RealAudio for more 



information.
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